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Introduction

Dashboard 95: The key to driving Windows 95!

Welcome to Dashboard 95, the high-powered, convenient utility that 
speeds up all your work with Windows 95. 

What’s new in
Dashboard 95?

Dashboard 95 contains new and improved features that will make 
your work in Windows faster and easier. Here are some of the 
highlights:

◆ Dashboard 95 is specifically designed to run in Windows 95 and to 
take advantage of its features.

◆ You can organize Quick Launch buttons into the new Quick 
Launch groups. 

Dashboard creates three system groups to give you instant access 
to your desktop, documents and Dashboard layouts. In addition, 
when you run Dashboard for the first time, the App Organizer 
scans your hard disk for common applications and creates groups 
and Quick Launch buttons for them. If you add applications later, 
the App Organizer finds them and adds them to the right groups.

◆ Layouts, which are arrangements of open programs in the 
Extended Screens, are now on the Quick Launch panel, so you can 
start several programs with a mouse click.

◆ Dashboard 95 provides single-click access to some of the most 
frequently used Windows 95 features, such as Find and the 
Explorer.

◆ The enhanced Resources panel monitors Windows 95 system 
resources, including CPU usage, threads in use, and number of 
“virtual machines”. The CPU activity meter shows you the 
heartbeat of your computer. 

◆ You can tile or cascade windows on the desktop with one click.

◆ The transition to Windows 95 is easier, because the Dashboard 
Programs panel preserves your Windows 3.1 program groups and 
provides single-click access to them.
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◆ The Dashboard Taskbar provides enhanced flexibility compared to 
the Windows 95 taskbar. Dashboard’s Taskbar can “float” in your 
workspace, and it can provide information about each task at the 
click of a button.

Where to go for
help

Your first source of help and information should be this manual and 
the online Help system. In addition, Starfish provides other support 
options: 

Fast fax information
Technical and product information sent directly to your fax machine 
in just minutes, any time of the day or night. 

800-503-3847

The Starfish BBS
Download the Technical Information notes you need, 24 hours a day.

408-461-5930

Free online information services
Discuss your questions and problems with other users and Starfish 
experts. 

On CompuServe, Go Starfish
On America Online, use the keyword Starfish
On Microsoft Network, the Go word is Starfish

Be sure to visit our Web site for product updates, companions and 
news (no technical support). http://www.starfishsoftware.com

Free up and running support
No-charge assistance for installation and initial configuration.

970-522-4610, 6 a.m. - 5 p.m. Pacific Time

Support hotline
All the help you need, at $2 per minute, first minute free:

1-900-555-1010, billed to your phone bill
1-800-953-9995, charged to your credit card
6 a.m. - 5 p.m. Pacific Time
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Chapter 1Installation

This chapter tells you what you need to run Dashboard and describes 
the Dashboard installation.

What’s in the
box

◆ A 3 1/2 inch disk

◆ This Dashboard User’s Guide

◆ A registration card

What you need
to run

Dashboard

Here’s what you need to run Dashboard:

◆ Hardware: Dashboard can run on any computer that will run 
Microsoft Windows 95. An IBM-compatible 386 computer with 
4Mb of memory is required; a 486 with 8Mb of memory is 
recommended.

◆ Software: Microsoft Windows 95.

◆ Hard Disk Space: Dashboard uses 3Mb of hard disk space when 
installed on your system.

What about a
mouse?

A mouse is recommended, but you can also use Dashboard without 
one. The User’s Guide uses the following terms to describe how you 
use the mouse:

◆ Click: Press and quickly release the mouse button.

◆ Double-click: Press and release the mouse button twice in rapid 
succession.

◆ Right-click: Press and release the right mouse button.

◆ Grab: Press and hold down the mouse button.

◆ Drag: Grab an item, move the pointer to new location, and release 
the button.



6 Chapter 1

Installing
Dashboard

Before you can use Dashboard, you must install it on your hard disk.

Please take a moment to read the Product License, Limited Warranty, 
and Limitation of Liability before installing. 

To install Dashboard
1 Start your Windows 95 computer, if you haven’t already.

2 Insert the Dashboard disk into drive A.

3 Click the Start button, and then choose Run.

4 Type A:INSTALL (if you are installing from Drive B, type 
B:INSTALL.

5 Follow the instructions provided on your screen. Windows finds 
the Dashboard installation program INSTALL.EXE, and runs it to 
install Dashboard.

Please register your copy of Dashboard. Registration keeps you up to 
date on news of Dashboard and other Starfish Software products.

After installation The first time you run Dashboard, your system is examined and the 
following features are automatically set up:

◆ Dashboard’s App Organizer scans your hard disk for common 
applications and creates Quick Launch groups and Quick Launch 
buttons for them.

Dashboard creates three system Quick Launch groups:

Desktop, containing all icons and shortcuts found on your 
Windows 95 desktop.

Documents, containing documents you have accessed recently. 
These are the same as the documents found on your Start menu 
Documents folder.

Layouts, containing all layouts you have defined. If you create 
a layout with three applications, for example, a single click on 
the icon in this group launches all three applications and 
positions them on your extended screens. 

NOTE   If you already have a copy of Dashboard, you can install directly 
over it. However, if you have a dual-boot Windows 3.1 and Windows 95 
computer, do not install Dashboard 95 over an existing version of 
Dashboard, because Dashboard 95 does not work with Windows 3.1.
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Then the App Organizer scans to find installed programs it 
recognizes, and arranges them in additional Quick Launch groups: 
Utilities, E-mail/Internet, and suites. You can add or delete 
applications and rename these groups as desired. 

◆ Dashboard creates tabs in the Programs panel for each of your 
Program Menu entries, and for each folder that contains program 
files. 

Dashboard soundsSome Dashboard features, such as the alarm clock, use sound. Your 
Dashboard disk includes several .WAV sound files. These sound files 
appear as choices in appropriate places when you are setting 
Dashboard preferences. If your computer is equipped with a sound 
card, then you can play the sounds contained in these .WAV files.

Any program groups you had in
Windows 3.1 are converted into tabs

on the Programs panel to simplify
your transition to Windows 95

Dashboard creates Quick Launch groups to 
contain applications on your hard disk
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Chapter 2Driver’s training:

Getting started
This chapter gets you started by describing the following Dashboard 
features that make your work in Windows faster and more efficient:

◆ An overview of Dashboard
◆ A graphical summary of the Dashboard controls
◆ A brief description of the individual panels that make up 

Dashboard
◆ Getting help while using Dashboard

What is
Dashboard?

Dashboard is an onscreen set of controls, gauges, and accessories for 
working with Windows quickly. Dashboard gives you convenient 
push-button control over everything you do in Windows.

You can launch programs from Dashboard with just the click of a 
button or a keystroke or two, or you can print or fax a file by simply 
dragging it to a Dashboard icon. A set of miniature screens shows 
which programs you’re working with; you can switch back and forth 
among them with a single click. Glancing at a panel, you can instantly 
check how much memory is available in your computer. Dashboard 
even has an alarm clock with a built-in snooze alarm. 

And one more thing: you can customize Dashboard to fit your 
personal style. It doesn’t matter whether you prefer a “luxury sedan” 
or a “sports car,” Dashboard will run the way you want.

What’s on the
Dashboard?

Dashboard provides quick and easy access to all the features of 
Windows. Three types of controls are on the Dashboard:

◆ Panels are groups of the most common features
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◆ Menus are pull-down lists of commands you can use

◆ Buttons are icons you click to control Dashboard

Panels Dashboard groups most controls into panels that you have complete 
control over:

◆ You can snap panels on and off the Dashboard for easier access.

◆ You can control the size of panels, and even hide them if you want.

◆ You can rearrange items on each panel, and rearrange panels on 
the Dashboard itself.

The Resources panel
tracks the levels of
system resources

Program groups from Windows 3.1,
and programs in the Windows 95

Start menu, become tabs in the
Program panel

The Win Tools panel 
provides single-click 
access to Windows 95 
features such as 
Explorer and Find

Use the Quick Launch 
panel to organize 
applications in tabs, and 
start an application with a 
single click

The Clock/Calendar panel lets
you set alarms to launch

programs or take other actions

Click an icon to change 
printers, or print by dragging a 
file icon to the Printers panel

Try your luck with poker,
slots, or the slide puzzle

in the Games panel

Extended Screens let you 
specify layouts and switch 
between groups of programs

Cascade or tile windows 
on the desktop with one 
click
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Menus Dashboard also provides three menus to help you work in the 
Windows environment.

Buttons Buttons let you snap Dashboard panels on and off, launch Dashboard 
Run and Help, and open the Customize dialog box.

Driver’s training Each Dashboard panel groups together common tasks that you 
perform in Windows. A panel’s shortcut menu is usually the fastest 
way to work with Dashboard.

To open a panel’s shortcut menu
Right-click the panel.

Each choice in a shortcut menu is a command that is also available 
elsewhere in Dashboard. For example, to hide a tab in the Program 
panel, you can either right-click the panel and choose Hide Group 

Use the Task menu to switch between open 
programs, display the Dashboard Run dialog box, or 
close all programs

Use the Layout menu to save your Dashboard 
screen layout—the placement and size of 
applications in the Extended Screens—and to 
manage other previously saved layouts
Layouts let you launch several applications with a 
single click

Access typical
Windows functions

with the System menu

These buttons let 
you snap panels on 
or off the Dashboard, 
or hide panels

Program panel

Quick Launch panel
Printer panel

Taskbar

Get context-sensitive 
help for any element 
on the Dashboard

Launch the 
Dashboard Run 
dialog box

Open the 
Customize 
dialog box

Open the 
Layout menu
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from the shortcut menu, or you can click the Customize button, select 
Programs from the Item to Customize list, select your program group 
from a list, click the Hide Group button, and click Done.

The shortcut menu for the Clock/Calendar panel is shown below.

Overview of panelsThe following sections provide a brief overview of each panel in 
Dashboard. For complete information about each panel, see the 
online Help or Chapter 4, “Cruising: The Dashboard panels.”

Quick Launch panel
The Quick Launch panel displays your most frequently used 
programs as buttons for easy access. Quick Launch groups organize 
your Quick Launch buttons by task, program, or project.

Right-click a panel to display a shortcut menu 
listing tasks you can perform with that panel
For example, the Clock/Calendar shortcut 
menu lets you change the display of the date 
and time, and lets you set alarms

Launch a program
with a single click

of a Quick Launch
button

Click a Quick Launch tab to display 
a different group of buttons
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Win Tools panel
The Win Tools panel provides single-click access to the most 
frequently used features of Windows 95. Choose the features that you 
work with all the time and display them on this panel.

Resources panel
The Resources panel contains information about your memory, 
Windows system resources, and your system environment. Use the 
Resources panel to examine resource usage and to set alarm levels for 
low resources.

Network Neighborhood

Explorer

My Computer

Find

The memory
meter displays
the amount of

free memory in
kilobytes and

graphically as a
percentage

The CPU meter displays information 
about CPU usage, threads, and VMs

The Drive Watch displays 
available disk space for 
drives that you specify

The CPU indicator shows how busy
your computer is.

Thread tells how many concurrent
execution threads are operating.

VM stands for Virtual Machine; your
Windows 95 environment is one VM,

any DOS windows are separate VMs.
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Clock/Calendar panel
The Clock/Calendar sets alarms that can launch programs or simply 
remind you of appointments, while keeping the date and time in a 
convenient display.

Printers panel
The Printers panel lets you change your default printer with a single 
click, and it prints any document that you drag to it.

Extended Screens panel
Extended Screens specify layouts and let you switch between groups 
of programs. Each extended screen represents a full-screen view. You 
can open programs on different Extended Screens and then switch 
between them, rather than piling up programs on the same screen.

Choose digital... ...or a variety of
analog styles

Click to change the 
default printer

Print by dragging to 
the default printer

Use scroll arrows to display 
other printers on the panel
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Games panel
The Games panel offers you a choice between poker, a slide puzzle, 
or a slot machine.

Dashboard Run
Dashboard Run displays a command line and a DOS command 
window from which you can execute DOS and Windows 95 
commands.

A minimized program is 
shown with a minimized icon

Clicking a screen 
selector activates 
its Extended 
Screen

Each running program is 
shown as a miniwindow

Launch a program by dragging it to an 
Extended Screen from a Quick Launch 
button, the Program panel, or the Explorer

Place your bet...

...and click to deal 
a hand of poker

The slot 
machine...

...and slide 
puzzles are 
also available

Enter DOS commands in
the Command Line box...

...or select a cofmmand
from the drop-down list.

The results of
commands appear in

the scrolling command
window
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Programs panel
The Programs panel displays a tab for each of the program in the 
Windows 95 Programs folder and the Windows 3.1 Program 
Manager. It is designed to make it easy for you to find and start your 
applications.

Taskbar
The Windows 95 Taskbar now provides some of the same 
functionality as the Dashboard Taskbar. However, you can snap off 
the Dashboard Taskbar, and you can get information about a task by 
right-clicking it in the Dashboard Taskbar and selecting Task Info.

...or launch it by 
clicking or dragging 
it to an Extended 
Screen

Click a tab to
display a menu

listing programs
it contains

Drag a program to the
Quick Launch panel

for easy access...

Snap the Programs panel 
off the Dashboard to turn it 
into a floating palette
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Like the Windows 95 Taskbar, the Dashboard Taskbar lets you switch 
between open applications. When you dock the Taskbar at the edge of 
the screen, it is available from any application.

Getting Help Dashboard Help lets you find the information you need quickly.

To display Help on any panel, button, or control on the 
Dashboard
1 Click the Help button on the Dashboard.

The mouse pointer changes into the Help pointer question mark.

2 Place the Help pointer on any item, and click to see the online Help 
topic for that item.

The Dashboard Taskbar
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To display Help about a dialog box
1 Open the dialog box.

2 Click its Help button. 

The Help Contents The Contents page lets you navigate easily in the Dashboard Help.

To display the Help Contents page
Do either of the following:

◆ Double-click the Help button on the Dashboard.

◆ Click the Contents button in any help topic.

Click the Help button...

...to display the Help
pointer. Click any item

on the Dashboard...

...to see Help for that item.

...displays Help
for the dialog box

Clicking the 
Help button...
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You can double-click any closed book on the Contents page to expand 
it and see the topics it contains, or double-click an open book to 
collapse it. Double-click an entry that contains the page icon to 
display the Help screen for that topic.

The Help Index You can also use the Help Index to find the exact topic you want 
information about. Like a book’s index, the Help Index contains an 
alphabetical list of index entries, and each entry is associated with one 
or more topics.

To display the Help Index
Do either of the following:

◆ Click the Index tab in the Contents page of the Help.

◆ Click the Index button in any help topic.

To use the Help Index
1 Type the first few letters of the word you are looking for.

2 Select an index entry from the scrolling list.

3 Click Display.

◆ If the index entry is associated with only one topic, that topic is 
displayed.

◆ If the index entry is associated with more than one topic, the 
Topics Found list is displayed.

Double-click an open
book to collapse it

Double-click a closed
book to expand it and

see the topics it
contains

Double-click an entry
that displays the page

icon to display the Help
screen for that topic
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4 If necessary, select the topic in the Topics Found list and click 
Display.

The Help full-text
search

You can use the full-text search feature of the online Help to search 
for any word that appears in the Help, even if it does not appear in the 
Index.

To display the full-text search
Do either of the following:
◆ Click the Find tab in the Contents page of the Help.

◆ Click the Find button in any help topic.

To use the full-text search
1 Type the first few letters of the word or phrase you are looking for.

2 Select one or more matches from the scrolling list.

The list of topics containing the selected word or phrase appears in 
the bottom panel.

3 Select a topic from the bottom panel.

Type the first
few letters of
the word you

are looking
for...

...select the
index entry

from the
scrolling

list...

If the index entry is associated with only 
one topic, that topic is displayed.
If the index entry is associated with more 
than one topic, the Topics Found list is 
displayed.

...then
click

Display
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4 Click Display to look at the topic.

Using ToolTips In addition to the online Help system, Dashboard provides ToolTips to 
identify the components of the Dashboard window.

To display ToolTips
Place the pointer over the item you want to identify, and wait for a 
couple of seconds.

A ToolTip appears, identifying the item.

To remove the ToolTip
Move the pointer off the item.

To disable ToolTips
Right-click the Dashboard title bar, and choose Disable ToolTips.

Type the first
few letters of
the word you

are looking
for...

...select one or
more matches

from the
scrolling list...

...then click
Display

...select the
topic that you

want to
view...

Use these 
buttons to 
set options 
and to 
further 
control 
your ability 
to search

ToolTip identifying the Sidekick 
Quick Launch button
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Chapter 3Getting up to speed

Most software programs try to make you work a certain way: their 
way. Dashboard recognizes that you’re an individual, that you have 
your own way of working, and that it may well be different from 
everyone else’s. You can customize Dashboard so it works just the 
way you want it to.

This chapter describes some of the basic tasks you perform with 
Dashboard, including the following:

◆ Using drag and drop
◆ Rearranging the Dashboard
◆ Launching programs
◆ Configuring panels

Using drag and
drop

Dashboard makes extensive use of drag and drop, where you can 
perform many tasks just by dragging with the mouse. Here are some 
of the ways you can use drag and drop:

◆ To launch a program, drag its icon from the Quick Launch panel or 
Programs panel to any of the Dashboard Extended Screens, or drag 
the .EXE file name from the Explorer.

◆ To create a new Quick Launch button, drag the program icon from 
a tab on the Programs panel to the Quick Launch panel, or drag the 
.EXE file name from the Explorer.

◆ To rearrange the Quick Launch buttons, drag the icons into their 
new positions.
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◆ To print a file, drag it from the Explorer to the current printer on 
the Printers panel.

Rearranging the
Dashboard

You can rearrange everything on the Dashboard to suit your personal 
working style. For example, you might want the Games on the far 
right and the Clock panel on the far left. And you might want to snap 
off the Quick Launch panel, but close the Taskbar and Extended 
Screens panels completely.

Rearranging
panels

The item list on the left side of the Customize dialog box lists all the 
currently installed Dashboard panels. The order in which the panels 
appear in this list corresponds to their order on the Dashboard. 
Rearrange the panels by dragging them in the list.

To change the position of panels on the Dashboard
1 Click the Customize button to display the Customize dialog box.

As you drag, the pointer
changes to this symbol
when you’re not over a

valid “drop zone”

When the pointer
changes to this

symbol, you can
release the mouse

button and drop the
item

You can print 
by dragging a 
file from the 
Explorer to the 
Printers panel

The snapped-off 
Quick Launch panel

The Quick Launch panel 
is snapped off, and the 
Taskbar and Extended 
Screens panel are closed
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2 Drag a panel up or down in the list to change its position on the 
Dashboard.

The higher up a panel is on the list, the farther to the left it appears 
on the Dashboard.

To change the position of a panel using the keyboard
1 Do either of the following in the list in the Customize dialog box:

◆ Use an arrow key to select the item.

◆ Use the first letter of its name.

For example, press Q to select the Quick Launch panel. (Note, 
however, that pressing P selects the Programs panel and then the 
Printers panel sequentially.) 

2 Press Ctrl+Alt and the arrow keys to reposition the item.

Adding and
removing panels

You might find that you need more room on the screen, or that you 
don’t want a panel visible on the screen. You can hide any panel; 
Dashboard itself is the only item that can’t be hidden.

To hide a panel from view
Do any of the following:

Click the 
Customize button 
to display the 
Customize dialog 
box

Drag a panel
up or down to

change its
position on the

Dashboard

You can 
rearrange the 
panels listed 
below this line

In this example:
- If Dashboard is displayed horizontally, the Quick Launch 

panel appears on the left and the Games panel on the right.
- If Dashboard is displayed vertically, the Quick Launch panel 

appears on the top and the Games panel on the bottom.
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◆ Select a panel in the left side of the Customize dialog box, then 
click Hide Item.

◆ Right-click a snapped off panel or a panel on the Dashboard, and 
choose Hide from the shortcut menu.

◆ Choose Close from the System menu of a snapped off panel.

Hiding a panel removes it from view, but it remains in memory. You 
can also remove a panel from view and memory.

To hide a panel from view and remove it from memory
1 Select Dashboard in the scrolling list on the left side of the 

Customize dialog box.

2 Click the Panels tab.

3 Select the panel you want to remove from memory in the Panels In 
Use list.

4 Click Remove.

...then click to hide or 
show the selected panel

Select a panel 
in the list...

...then click to 
remove it

Select a panel 
in the list...
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Resizing the
Dashboard

You can change the size of the entire Dashboard, and you can also 
resize the Quick Launch panel and the Printers panel.

To adjust the size of the entire Dashboard
1 Move the pointer to the edge of the Dashboard window.

2 When the pointer changes to a sizing arrow, drag up or down.

Changing the size of the Dashboard can change its behavior and 
appearance:

◆ Compressing Dashboard vertically can change the appearance of 
some of the panels. For example, the Quick Launch panel may 
display a single row of buttons instead of two rows of stacked 
buttons.

◆ Compressing Dashboard horizontally can make the Printers panel 
or Quick Launch panel too small to show all of their items. In that 
case, scroll bars appear that allow you to scroll among the items.

To resize the Quick Launch panel or Printers panel
1 Hold down the Shift key and move the pointer to the edge of the 

panel.

2 When the pointer changes to a sizing arrow, drag the gray border 
that appears.

The panel displays as many items as possible in the space you 
define.

Snapping off
panels

You can snap the following panels off or on the Dashboard:

◆ Programs panel
◆ Quick Launch panel
◆ Printers panel
◆ Taskbar

Drag the 
side 
borders to 
change 
the width

Drag the top or bottom borders 
to change the height

Hold down the Shift key and 
drag to resize individual panels
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To snap a panel off or on
Do any of the following:

◆ Right-click the panel and choose Snap On or Snap Off from the 
shortcut menu.

◆ Click a panel button at the left of the Dashboard.

◆ Check the panel as a Snap-Off Panel in the Customize dialog box.

Running
Dashboard

vertically

Not only can you rearrange the panels on the Dashboard, you can 
even flip it into a vertical position, if you prefer.

To place Dashboard in a vertical position
1 Right-click the title bar.

2 Choose Vertical from the shortcut menu.

Click the
buttons to

snap a panel
off or on

Check the 
panels you 
want to snap 
off the 
Dashboard

Click Dashboard in
the list of panels...

...then click the Snap 
Off tab to display the 
list of snap off panels
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Launching
programs

To launch a program in Dashboard
Do any of the following:

◆ Click a Quick Launch button.

◆ Drag a program icon or file name to the Extended Screens.

◆ Open a tab on the Programs panel, and then click the program icon 
or name.

◆ Include the program as part of a layout.

◆ Use the DOS command line in the Dashboard Run dialog box.

◆ Set an alarm to launch the program. See “Setting an alarm” on 
page 59. 

NOTE   If you type a program name that includes one or more spaces, type 
quotation marks around the application (and path) name, like this: 
“c:\applications\my calculator.exe”

Right-click the title bar and 
choose Vertical from the 
shortcut menu to place 
Dashboard in a vertical 
position.

You move and size Dashboard 
the same way whether it is 
displayed vertically or 
horizontally.
If you resize the vertical 
Dashboard, some panels adjust 
to fit in the space you’ve defined. 
For example, the Extended 
Screens panel might not display 
the screen selectors if there is 
not enough room. In this case, 
double-click the screens 
themselves to switch back and 
forth, or adjust the size of 
Dashboard by dragging its 
edges.
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Using Quick
Launch buttons to
launch programs

To launch a program with the Quick Launch buttons
Do any of the following:

◆ Click its Quick Launch button. The program starts in your current 
Extended Screen.

◆ Drag a Quick Launch button to a full-size Extended Screen. The 
program starts in that Extended Screen, but Dashboard does not 
switch focus from the current screen.

◆ Press its hotkey. Every button on the Quick Launch panel can have 
a hotkey assigned to it. For example, you could set Sidekick 95 to 
launch when you press Ctrl+Alt+S.

See “Quick Launch panel” on page 44 for complete information 
about Quick Launch buttons.

Using Extended
Screens to launch

programs

To launch a program in an Extended Screen
Drag a program icon or file name to an Extended Screen from any of 
the following:

◆ Any Quick Launch button

◆ A tab in the Program panel

◆ A program group window

◆ The Explorer

See “Extended Screens panel” on page 65 for complete information 
about Extended Screens.

Launching
programs from the

Programs panel

To launch a program from the Programs panel
1 Find the tab that contains it on the panel.

Each tab corresponds to a Program Menu group, or a folder 
containing an application, or a .GRP file. 

2 Click a tab to see a list of all the programs in that group.

Click a button on the Quick
Launch panel, type its hotkey,

or drag it to an Extended
Screen to launch a program

Use the scroll arrows to see other 
Quick Launch buttons if you have 
more than will fit on the screen
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3 Click the program you want to run.

Using the Layout
menu to launch

programs

A layout is like a freeze-frame picture of Dashboard at a specific 
moment, including any open programs arranged in specific positions. 
You can save layouts, which then appear in the Layout menu and in 
the Layout tab of the Quick Launch panel.

To display the Layout menu
Do any of the following:

◆ Click the Layout button

◆ Choose Layout Menu from the System menu.

When you choose from the layout list, you automatically launch all 
the programs saved as part of that layout. They are placed in the same 
positions on the Extended Screens that they occupied when the layout 
was saved. If a program was minimized when it was saved as part of a 
layout, it will be minimized when that layout is opened.

See “Creating and using layouts” on page 70 for complete 
information about layouts.

To launch a 
program, click the 
program name

Programs Panel

Scroll arrows let
you see more

program groups

Layout 
button

Layout 
menu
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Launching
programs with the

Run dialog box

The Dashboard Run dialog box contains both a command line and a 
command window from which you can execute commands to search 
directories, copy files, and launch programs.

To display the Dashboard Run dialog box
Do either of the following:

◆ Click the Run button.

◆ Choose Dashboard Run from the Task menu.

See “Dashboard Run” on page 75 for a complete description of the 
Dashboard Run window.

Managing open
programs

In addition to the Extended Screens, Dashboard gives you three ways 
to keep track of your currently running programs, or tasks, and to 
switch between them.

To manage open programs
Use any of the following:

◆ The Task Manager takes the place of the Windows Task Manager. 
See “The Dashboard Task Manager” later in this section.

Enter the command line for the
program to run. Or enter DOS

commands here.
Check this box if you want the
program minimized when you

open it.

Command window.

Use the Browse button to find the 
program’s location and file name.

Click here to pick a command 
from the command history list.

Click here to run the command in 
the Command Line box.

Or double-click the program to 
run it. Or select it as described 
above and press Enter.

Click the 
Run button...

...or choose
Dashboard Run

from the Task menu
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◆ The Task menu lists each task and contains other task management 
commands. See “Menus” on page 11 for an illustration and more 
information.

◆ The Taskbar contains a button for each task. Clicking the button 
instantly activates that task. Or you can right click a task on the 
Taskbar to get task information.

The Dashboard Task Manager
When you install Dashboard, it automatically replaces the Windows 
Task Manager with its own task manager (unless you switch back to 
the Windows 95 Task Manager using configure).

To see the Dashboard Task Manager
Click the Task Manager button on the Win Tools panel, or press 
Ctrl+Esc.

You can use the Task Manager to switch to running programs, close 
selected programs, tile or cascade your program windows, or display 
information about a program.

The Application Task Information dialog box shows detailed 
information for the selected program. 

Configuring
panels

You can customize the appearance and behavior of every panel in 
Dashboard, and of Dashboard itself. Use the Customize dialog box to 
specify your Dashboard preferences.

The Task List shows all running
programs that aren’t minimized.

These programs are
running, but minimized.

Click here to activate the
selected program in either

list. You can also double-click
the program name in the list.

Arrange Icons rearranges all 
minimized icons in every Extended 
Screen according to available space.

Click here to close the selected 
programs in either list.

Click here to display the Application Task 
Information dialog box for the selected 
program.

The Tile and Cascade options tile or cascade the 
applications that share Extended Screens.
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To open the Customize dialog box
Do one of the following:

◆ Right-click the Dashboard and choose Customize.

◆ Click the Customize button.

Chapter 4, “Cruising: The Dashboard panels” and the online Help 
both provide complete information about configuring the individual 
Dashboard panels.

Saving custom
configurations

After you configure Dashboard the way you want it, save your 
configuration so you can use it again.

To save the configuration
1 Display the Customize dialog box.

2 Choose Save from the File menu.

The configuration is saved under the current name (the name that 
appears in the title bar of the Customize dialog box).

To create a new configuration
1 Display the Customize dialog box.

...or click the
Customize

button to display
the Customize

dialog box

Right-click the 
Dashboard 
and choose 
Customize...

Select the panel 
that you want to 
customize...

...then set your 
preferences for 
the selected panel
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2 Choose Save As from the File menu.

The Save Configuration File dialog box appears.

3 Enter a name for the new configuration, then click Save.

Using custom
configurations

You can create and save as many Dashboard configurations as you 
want. For example, you can create separate configurations called 
HOME.CFG and OFFICE.CFG that set Dashboard up for different 
purposes.

Type a new file name for 
the configuration you’re 
saving. Dashboard 
automatically adds the 
.CFG extension.

Create as many Dashboard 
configurations as you want.

For example, you can create a 
configuration for your home use...

...and another for your
home office use.
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To use a Dashboard configuration that you’ve previously created 
and saved
1 Display the Customize dialog box.

2 Choose Load from the File menu.

The Load Configuration File dialog box appears.

3 Choose the path and name of the file to load, then click Open.

Saving and
undoing changes

to your
configuration

When you change an option in the Customize dialog box, you see the 
change reflected immediately on the Dashboard.

To keep the changes you’ve made
Click Done. The Customize dialog box closes, and Dashboard saves 
your changes to the configuration file named in the dialog box’s title 
bar. (For information on configuration files, see “Configuring panels” 
on page 33.)

To discard your changes
Click Undo. Dashboard discards all changes made since the last time 
you saved the configuration file.

Enter the path and name 
of the configuration file to 
load, then click Open
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4
Chapter 4Cruising:

The Dashboard panels
The Dashboard panels offer many features. This chapter explains how 
to set up and use the following panels and features:

◆ Setting Dashboard preferences, page 38

◆ Quick Launch panel, page 44

◆ Win Tools panel, page 50

◆ Resources panel, page 51

◆ Clock/Calendar panel, page 56

◆ Printers panel, page 61

◆ Extended Screens panel, page 65

◆ Games panel, page 74

◆ Dashboard Run, page 75

◆ Programs panel, page 77

◆ Taskbar, page 84
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Dashboard
preferences

You can customize the appearance and behavior of Dashboard itself. 
This section describes how to use the Customize dialog box to set 
Dashboard preferences. These are “global” preferences that apply to 
the Dashboard as a whole.

Opening the
Customize dialog

box

Use the Customize dialog box to specify Dashboard preferences.

To open the Customize dialog box
Do one of the following:

◆ Right-click the Dashboard title bar and choose Customize.

◆ Click the Customize button.

In the Customize dialog box, select Dashboard as the item to 
customize. The Customize dialog box for Dashboard has five pages: 
Dashboard, Hotkeys, Appearance, Snap Off, and Panels. In addition, 
the items on the left side of the Customize dialog box let you 
rearrange panels, hide panels, and undo changes you’ve specified.

Right-click a panel 
to display its shortcut menu
From the shortcut menu, choose 
Customize.

Or click the Customize button,
and select the panel you want

to set up
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Dashboard page  You can specify how Dashboard appears on the screen and how it 
behaves. 

Select
Dashboard to

specify its
preferences.

Click the tab for the 
Dashboard page.

Specifies that the Dashboard always appears 
in front of other windows, even if another 
window is active. When this option is not 
checked, you must activate Dashboard to 
bring it to the front.

Replaces the Windows 
Task Manager. See 
“The Dashboard Task 
Manager” on page 33.

Specifies that icons 
appear in the 
Extended Screens and 
in the Programs panel’s 
menus. If not checked, 
these items contain 
only text.

Specifies what appears in the Dashboard 
title bar: the Dashboard name only, the 
date and time, or the current state of 
system resources and memory.

Specifies whether the Dashboard is horizontal 
or vertical. See “Running Dashboard vertically” 
on page 28.

When checked, minimizing Dashboard 
causes it to appear as an icon in the system 
tray of the Windows 95 Taskbar.



40 Chapter 4

Hotkeys page You can specify a hotkey and a mouse shortcut for activating 
Dashboard, and a hotkey for displaying the Dashboard Run dialog 
box.

Defining hotkeys
To define a hotkey, type it directly into the text box in the Customize 
dialog box. You can use several types of keys:

◆ Function keys F1–F9 and F11–F24 (if you have them)

◆ Modifying keys (such as Alt, Shift, and Ctrl)

◆ ASCII keys

◆ Arrow keys

Appearance pageYou can

◆ Set the font Dashboard uses in the Programs panel, title bar, and 
Extended Screens.

TIP

Choose a key sequence that is 
unique and easy to remember.

NOTE   To avoid hotkey conflicts, Dashboard might redefine your key 
sequence slightly. For example, if you type Ctrl+S (which is the Windows 
standard for saving a file), Dashboard records the hotkey as Ctrl+Alt+S. 
When you type the hotkey, Dashboard displays the substituted key 
sequence.

Specify a key 
sequence that brings 
Dashboard or the 
Explorer to the front.
See the following 
section, “Defining 
hotkeys.”

A mouse shortcut for bringing Dashboard to the front. 
Select the default setting “Left + Right Buttons,” then 
click the combination you want. A mouse shortcut can 
be a combination of any modifying key (Alt, Shift, or Ctrl) 
and the mouse buttons.

Specify a key 
sequence that 
displays the 
Dashboard Run dialog 
box.
See the following 
section, “Defining 
hotkeys.”

Select
Dashboard to

specify its
preferences.

Click the tab for the 
Hotkeys page.
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◆ Specify one of Dashboard’s predefined color schemes for its 
window and snapped-off panels.

NOTE   The color scheme you select applies only to the Dashboard and 
snapped-off panels, not the Extended Screens or the Windows Desktop. To 
change the Extended Screens background color or pattern, see “Extended 
Screen preferences” on page 66. To change the Windows Desktop color 
scheme, right-click the desktop and choose Properties.

Lists the fonts currently 
installed on your 
system. Select a font 
from this list.

Select the point size. 
Depending on the font, 
the smallest point size 
available is 6 points; the 
largest is 12 points. The 
Dashboard resizes 
according to the font.

Choose a style, such as 
Bold or Italic (when 
available for the 
selected font).

Click to reset the 
default colors and the 
font to 7-point, Small 
Fonts, Plain.

Color scheme selector buttons.

Select
Dashboard to

specify its
preferences.

Click the tab for the 
Appearance page.
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Snap Off page You can snap off the Programs panel, Quick Launch panel, Taskbar, 
and Printers panel. For example, if you snap off the Programs panel, 
you don’t have to scroll to find a Program Group.

You can also snap off a panel by doing either of the following:

◆ Right-click it and choose Snap Off from the shortcut menu.

◆ Click its snap-off button on the left side of the Dashboard, as 
shown in “Buttons” on page 11.

A triangle in the upper-right corner of the button indicates that the 
panel is snapped off; a triangle in the lower-left corner indicates 
that the panel is snapped on. Clicking the button displays the panel 
if it has been hidden. Right-click the button to customize the panel.

The hotkey sequence that brings Dashboard to the front (see 
“Hotkeys page” on page 40) brings snapped-off panels to the front as 
well.

You can place a snapped-off panel anywhere on the screen, and its 
position remains consistent on every Extended Screen.

Panels page You can add or remove several Dashboard panels. When you remove 
a panel on the Panels page as described here, the panel is removed 
from both view and memory. You can also hide a panel from view as 

Select which panels to 
snap off

Check to have snapped-
off panels minimize when 
you minimize Dashboard

Check to enable 
ToolTips

Select
Dashboard to

specify its
preferences

Click the tab for the 
Snap Off page
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described in “Adding and removing panels” on page 25, but it 
remains in memory.

To add a panel
Select it in the Available Panels list, and click Add.

To remove a panel
Select it in the Panels In Use list, and click Remove.

For information on rearranging panels, see “Rearranging the 
Dashboard” on page 24.

Panels that are 
available, but not in 
use

Panels that are in use

Select
Dashboard to

specify its
preferences

Click the tab for the 
Panels page
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Quick Launch
panel

Use the Quick Launch panel to launch programs with a single click, 
and to group the programs you use most frequently. You can easily 
add programs to the panel and rearrange programs within the panel.

Dashboard starts with three system groups already created for you:

◆ Desktop, containing all icons and shortcuts found on your 
Windows 95 desktop.

◆ Documents, containing the 15 documents you have accessed most 
recently. These are the same as the documents found on your Start 
menu Documents folder.

◆ Layouts, containing all layouts you have defined. If you create a 
layout with three applications, for example, a single click on the 
icon in this group launches all three applications and positions 
them on your extended screens. 

In addition, when you first run Dashboard, the App Organizer 
searches for applications, and puts them into additional groups: 

◆ Utilities , for Paintbrush and other Windows 95 utility programs.

◆ Email/Internet  for your email software, Web browser, and others.

◆ Microsoft Office, Perfect Office, or SmartSuite, if you have any 
of these multi-product office packages installed.

Display a shortcut menu 
by right-clicking the 
Quick Launch panel

Snap the Quick Launch panel on or off by 
clicking the Quick Launch panel button or by 
choosing Snap Off from the shortcut menu

Display a shortcut 
menu by right-clicking 
the Quick Launch panel

The Quick Launch panel
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You can move programs from one group to another, rename a group, 
and otherwise control just how your Quick Launch groups work.

Quick Launch
preferences

Use the Customize dialog box to specify your preferences for the 
Quick Launch panel. Display the Customize dialog box as described 
in “Dashboard preferences” on page 38.

The Customize dialog box for the Quick Launch panel has three 
pages: Applications, Groups, and Options.

Launch a program by 
clicking its icon.

Add a program to the 
panel by dragging it 
from its menu to the 
panel. Or drag it from 
the Explorer.

Rearrange
programs by

dragging them.

To resize the Quick Launch panel, hold down the 
Shift key and move the cursor to either edge of the 
panel. When the cursor changes to a sizing arrow, 
resize the panel. The panel displays as many 
buttons as possible in the space you’ve defined.

Display a
different Quick

Launch group by
clicking its tab.
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Applications page
You can add, delete, and reorder programs. You can also specify 
hotkeys and working directories for programs.

Groups page
You can add and delete Quick Launch groups. You also can reorder 
tabs by dragging them within the list. 

To change the order of the programs, drag 
a program to a new position in the list.

Adds a program to the 
panel. See “Creating 
Quick Launch buttons” 
on page 48.

Specifies the 
program’s location.

Specifies the program’s 
title.

Deletes the selected 
program from the panel.

Specifies the program’s 
working directory, which 
the program uses when 
opening and saving files.

Specifies a key for 
launching the 
program. See 
“Specifying hotkeys” 
on page 50.

Lets you look for the 
path to the program’s 
location.

Changes the icon that 
appears on the Quick 
Launch panel.

Specifies that the 
program runs 
minimized when 
launched.

Select Quick
Launch to
specify its

preferences.

Click the tab for the 
Applications page.

Select the group of 
programs to work with.

Select Quick
Launch to
specify its

preferences

Click the tab
for the

Groups page

Select the group of 
programs to work with

Adds a group

Deletes the selected 
group

Lists the name of the 
selected group. Type a 
name to rename the 
group.

Lists the applications in
the selected group

Show or hide system group
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Options page
 You can change the appearance of the Quick Launch panel and sort 
your Quick Launch groups.

The Re-Synchronize button updates the three system Quick Launch 
groups (Desktop, Documents, and Layouts) to reflect any changes 
you have made in, for example, shortcuts on the desktop. It also runs 
the App Organizer, which scans for known applications and puts them 
into one of the pre-defined Quick Launch groups (see page 44).

Specifies the appearance of the 
buttons on the Quick Launch panel.

Unlabeled Labeled Mini

Select Quick
Launch to
specify its

preferences.

Click the tab for the 
Options page.

Sorts your Quick Launch 
groups. Choose 
Alphabetically or By 
Personal Preference, 
and then click Sort 
Groups. 
By Personal Preference 
sorts the most recently 
used to the start of the 
list, immediately following 
the three system groups.

Click Re-Synchronize to 
update your Quick 
Launch groups (see text).



48 Chapter 4

Creating Quick
Launch groups

To create a Quick Launch group
Use the Customize dialog box as follows.

Creating Quick
Launch buttons

You can create as many as 128 Quick Launch buttons.

To create a Quick Launch button
Do one of the following:

◆ Drag a program file (such as SIDEKICK.EXE) from the Explorer, 
an open Dashboard program group, or the Dashboard Programs 
panel, to the Quick Launch panel.

◆ Drag a data file (for example, MEMOS.DOC) from the Explorer to 
the Quick Launch panel. The file’s extension must be associated 
with the program, as described in “Launching a program and 
loading a file” on page 49.

◆ Make a copy of an existing Quick Launch button by holding down 
the Ctrl key and dragging it to a new location.

3 Click New.
4 Type a name for the 

group.
1 Select Quick 

Launch.

2 Click the tab for the 
Groups page.
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Use the Customize dialog box as follows:

Launching a
program and
loading a file

You can set up a Quick Launch button to load a data file at the same 
time it launches the program.

To set up a Quick Launch button to load a data file

Enter the full paths to the program and the data file into the Command 
text box in the Quick Launch Applications page, in this format: 

C:\WINDOWS\PBRUSH.EXE D:\ARTWORK\PICASSO.PCX

If an association for the data file extension exists, you need to enter 
only the path to the data file. (To create an association, double-click 
My Computer and choose Options from the View menu. Then, click 
the tab for the File Types page. If you’re not familiar with 
associations, see your Windows documentation.) For example, to 
launch Microsoft Word for Windows and load a data file named 
MEMOS.DOC, enter this into the Command Line text box:

C:\WINWORD\DOC\MEMOS.DOC

The file names must include extensions.

If a file name association exists, you can instantly create a Quick 
Launch button that loads a data file by dragging the data file name 
(for example, MEMOS.DOC) from the Windows Explorer to the 
Quick Launch panel.

Check this box to open the 
program minimized when you 
click the Quick Launch button.

3 Click New.
4 Type a descriptive 

name for the 
program. You can use 
any name you like.

5 Enter the full path to 
the program’s .EXE 
file. You can also use 
the Browse button to 
get the path 
information.

1 Select Quick 
Launch.

2 Click the tab for the 
Applications page.

To delete an application,
select it in the Applications

window, and click Delete.
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Specifying hotkeys A hotkey for a Quick Launch program launches the program.

For information on defining a key sequence, see “Defining hotkeys” 
on page 40.

If an open program is minimized, behind other windows, or in 
another Extended Screen, the hotkey brings it to the front and 
switches to the proper Extended Screen. If the program lets you 
launch multiple copies at the same time, the hotkey will launch a 
copy.

When working in DOS (either full-screen or in a window), you 
cannot use a hotkey to launch a program.

Win Tools The Win Tools panel offers single-click access to frequently used 
Windows 95 features such as Find and the Explorer.

The Win Tools panel

Display a shortcut menu by right-
clicking the Win Tools panel to 
customize Win Tools
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Win Tools
preferences

Use the Customize dialog box to specify your preferences for the Win 
Tools panel. Display the Customize dialog box as described in 
“Dashboard preferences” on page 38.

You can assign a program to each button on the Win Tools panel.

Resources panelOne of the strengths of Windows is the fact that you can run more 
than one program at a time. However, the more programs you run, the 
more likely you are to run out of memory, resources, or disk space.

Launch a program like the
Explorer by clicking a button

on the Win Tools panel

Select Win
Tools to specify
its preferences

For each tool, select a 
program from the list
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Use the Resources panel to keep an eye on system resources:

◆ The Resource Gauge displays the amount of available memory you 
have.

◆ The Drive Watch portion of the Resources panel monitors the 
space on your disk drives.

◆ The CPU meter shows CPU activity, thread usage, and virtual 
machines, as shown below.

Reading the
Resource Gauge

Each running program uses up a portion of system memory. The 
Resource Gauge displays the percentages of what Windows 95 refers 
to as swappable system memory. The meter drops toward empty as 
the percentage of available memory decreases.

The Resources panel

Display a shortcut 
menu by right-clicking 
the Resources panel

The Resource Gauge
reports the amount of

available memory

The Drive Watch shows 
the available disk space 
on drives you want to 
monitor, including 
network and floppy disk 
drives

Double-click the Resource Gauge 
or Drive Watch to see further 
details

The CPU meter tracks: 
CPU usage, or how busy your central 
processing unit is, 
Threads, or simultaneous activities, 
and Virtual Machines (Win 95 is one VM, and 
DOS windows are separate VMs).
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You can display the Resource Gauge as a fuel gauge or as a bar gauge.

When you are low on memory, an optional alarm sounds and the 
warning indicator in the fuel gauge or the bar gauge begins to blink.

Resources
preferences

You can specify preferences for the Resources panel by using the 
Resources dialog box or the Customize dialog box.

To specify your preferences for the Resources panel
Do one of the following:

◆ Double-click the Resources panel, or right-click it and choose 
Details from the shortcut menu. The Resources dialog box appears, 
with five sections:

Memory and Resources displays the current state of your 
memory and system resources.

System Environment lists information about your computer, such 
as the processor type, display type, and output devices.

Drive Usage displays available disk space on each drive, including 
floppy disk drives, hard disk drives, and network drives.

Applications Running lists currently open programs and their 
memory size.

Environment Variables lists the DOS environment variables 
currently being used.

The following sections describe these pages.

◆ Display the Customize dialog box as described in “Dashboard 
preferences” on page 38. The Customize dialog box for the 
Resources panel has three pages:

Memory. These settings are the same as the Memory and 
Resources preferences in the Resource dialog box. See the 
following section, “Memory and Resources preferences.”

Available 
memory

Warning indicator

Memory odometer

Available 
memory

Bar gaugeFuel gauge
 Memory odometer
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Drives. These settings are the same as the Drive Usage preferences 
in the Resource dialog box. See “Drive Usage preferences” on 
page 55.

Memory and Resources preferences
You can view the current state of your memory usage, set alarm 
levels, and choose how and whether the resource monitors are 
displayed.

The alarm sounds when available memory reaches the warning values 
you set. For example, if you enter 100 for the alarm level, the alarm 
will sound when 100Kb or less of memory is free.

System Environment preferences
You can view information about your computer, such as the processor 
type, display type, and output devices.

Click Memory and
Resources

Specifies the type of 
Resource Gauge 
displayed. 

Selects the alarm sound. 
Click Play Sound to hear 
the alarm

These settings 
determine when the 
alarm sounds

Check to display the 
Resource Gauge

Check to display the
memory odometer

Click System
Environment
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Drive Usage preferences
You can view the available disk space on each drive, including floppy 
disk drives, hard disk drives, and network drives, and you can 
configure the Drive Watch on the Dashboard.

Applications Running preferences
You can view currently open programs and their memory size.

NOTE   The Update Interval (how often Drive Watch checks your drives) 
might affect performance, especially with large network drives. Experiment 
with various settings to determine the optimum interval for your system.

Click Drive Usage.

Check to display the
Drive Watch as part of
the Resources panel.

Specifies how often to 
check the available space 
on each drive.

Lists available drives.

Removes the selected 
drive from the Drive Watch 
on the Dashboard. If the 
selected drive is not 
currently displayed, the 
button is labeled Add and 
you can add the drive to 
the display.

Updates the list of available drives. 
For example, if you insert a disk into 
your floppy drive, click Refresh to 
have it appear in the list.

Click Applications
Running
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Environment Variables preferences
You can view the DOS environment variables currently being used.

Clock/Calendar
panel

The clock and calendar display your system date and time. You can 
set your system date and time, scroll through the display of months, 
and set alarms.

Click
Environment

Variables

Display a shortcut 
menu by right-clicking 
the Clock/Calendar 
panel

The Clock/Calendar panel
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Clock/Calendar
preferences

Use the Customize dialog box to specify your preferences for the 
Clock/Calendar panel. Display the Customize dialog box as described 
in “Dashboard preferences” on page 38.

The Customize dialog box for Clock/Calendar panel has three pages: 
Clock, Calendar, and Alarms.

To set your system date or 
time, right-click the panel 
and choose Change Date/
Time from the shortcut 
menu

Today’s date is 
highlighted

Change months by 
clicking the arrows

To add or change an 
alarm, double-click 
the panel or click the 
date you want
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Clock page You can turn the clock on or off and select a clock style.

Calendar page You can turn the calendar on or off, specify color highlights, and 
change your system date and time.

NOTE   If you’re using a communication program that has a time-out 
feature, turn the Second Hand option off to avoid a time-out every time the 
clock repaints the second hand.

Select Clock/
Calendar to

specify its
preferences

Click the tab for 
the Clock page

Check to display a 
second hand on the 
analog clock

Check to display the clock

Choose an analog 
or digital clock

Choose a clock face

Select Clock/
Calendar to

specify its
preferences

Click the tab for the 
Calendar page

Goes to today’s date 
in the calendar

Select colors to 
indicate today’s date 
and days with alarms

Sets your computer’s 
date and time

Check to turn off color 
indicators in the 
calendar

Check to display the calendar
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Alarms page You can set, change, and remove alarms, and specify a snooze 
interval.

When an alarm appears, you can click Snooze to shut it off 
temporarily. The alarm will sound again after a set number of minutes 
known as the snooze interval.

Setting an alarm Dashboard alarms can help you keep track of your busy schedule. 
You can set an alarm to remind you of an appointment or to launch a 
program. You can repeat the same alarm every day or on a specific 
day of the week. And you can set an alarm weeks, or even months, in 
advance.

To set an alarm
Do one of the following:

◆ Click the date you want in the calendar. (This displays alarms only 
for that date.)

◆ Double-click the clock.

◆ Right-click the clock or calendar, and choose Alarms.

Select Clock/
Calendar to

specify its
preferences

Click the tab for 
the Alarms page

Sets an alarm (see the 
following section)

Sets the snooze interval

Disables all alarms

Changes or removes the 
selected alarm

Lists all alarms that you 
have set
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When you click the Add or Edit button, you can specify alarm 
settings.

Dates with alarms are highlighted on the calendar.

Launching programs with alarms
To set an alarm to launch a program
1 Enter the program’s path and working directory in the Application 

section of the Alarm Settings dialog box.

2 Check the Run Minimized box to have the program opened 
minimized.

When the alarm goes off, Dashboard launches that program and 
displays the alarm message you entered.

Lists all the alarms you’ve set
To see only the alarms set for a
specific date, click that date in

the calendar
Changes the selected alarm

Creates an alarm

Removes the selected alarm

Sets the snooze interval

Disables all alarms

Specifies the alarm message text.

To set a one-time alarm, select Date. Set 
the date by typing it, or select the month, 
day, or year, and click the arrows.
To set a recurring alarm, select Recurring 
and choose the frequency from the menu.

Launches a program with the alarm. 
See the description below.

Selects the alarm sound. Click Play 
Sound to hear it.

Specifies the alarm time.
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How alarms are displayed
When an alarm goes off, a message box appears. You can either click 
OK to close the alarm message box or click Snooze to close the alarm 
message for a specified snooze interval.

If you don’t close the alarm message within an hour, Dashboard 
closes it.

To adjust the volume and duration of the alarm sound
Use the Multimedia program in the Windows Control Panel.

Printers panel The Printers panel lists all the currently installed printers, fax 
machines, plotters, and other output devices.

NOTE   Alarms appear only when Dashboard is running.

Your alarm message appears here

Display a shortcut 
menu by right-clicking 
the Printers panel

Snap the Printers panel on or off by 
clicking the Printers panel button or by 
choosing Snap Off from the shortcut menu

Display a shortcut 
menu by right-clicking 
the Printers panel

The Printers panel
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Printers panel
preferences

Use the Customize dialog box to specify your preferences for the 
Printers panel. Display the Customize dialog box as described in 
“Dashboard preferences” on page 38.

The Customize dialog box for the Printers panel has two pages: 
Printers and Options.

To print or fax a file, drag the file to the 
Printers panel from the Explorer, the 
Programs panel, or a program window.
When you drag a file to a printer other 
than the default, that printer becomes the 
default.

A green light indicates the 
default printer. To change 
the default printer, click a 
printer’s button.

To change the order of the printers in the Printers panel, 
drag the printer icons into the positions you want.

Double-click a printer’s
button to set up the printer.
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Printers page
You can change the order of the printers, hide a printer, pick a 
different printer icon, or give each printer a unique description.

NOTE   The Dashboard Printers panel does not install printers. To install a 
printer or assign it to a printer port (such as LPT1), use the Printers section 
of the Windows Control Panel. For details, see your Windows 
documentation.

Select Printers to
specify preferences

for the Printers panel.

Click the tab for 
the Printers page.

Current default 
device.

Currently installed 
printers. To change the 
position of a printer icon, 
drag it to a new location.

Shows the icon used in 
the printer button for the 
selected device.

The description you 
enter appears on the 
printer button and in the 
ToolTips.

Removes the selected 
device from the 
Dashboard window. The 
item remains in the list of 
installed devices, but it 
isn’t visible.

Makes the selected 
printer the default 
printer.

Lets you set up the printer. 
This is the same as 
choosing Printer Setup 
from the File menu in many 
applications.

Lets you select an icon 
for your printer button.
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Options page
You can specify whether to show the paper orientation in the Printers 
panel.

Drag-and-drop
printing

You can print or fax a file by dragging it to the Printers panel.

To print or fax a file
Drag the file to an icon on the Printers panel from the Explorer, the 
Programs panel, or a program window.

◆ If the file was created in a program that has printing options (such 
as a page range or image scaling), Dashboard opens the program, 
loads the file, and displays the program’s print dialog box.

◆ If the program has no printing options (Windows Notepad, for 
example), Dashboard opens the program and loads the file just 
long enough to print the file.

Programs that support drag-and-drop printing are listed in the 
Windows registration database. If a program is not listed in this 
database, drag-and-drop printing will not work. Consult your 
Windows documentation for information on how to add an unlisted 
program to the Windows registration database.

Check to display the 
orientation (portrait 
or landscape) with 
the printer’s icon in 
Dashboard

Orientation 
shown

Orientation 
not shown

Click the tab for 
the Options page

Select Printers to
specify preferences

for the Printers panel
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Extended
Screens panel

Using Dashboard’s Extended Screens is like connecting your 
computer to several side-by-side monitors. Each Extended Screen 
represents a full-screen view. You can open programs on the Extended 
Screens and then switch back and forth among them to work with the 
different programs.

For example, suppose you want to work with Sidekick, Paradox for 
Windows, and Quicken. Rather than piling these programs up on the 
same screen, open Sidekick on the first Extended Screen, Paradox on 
the second, and Quicken on the third.

The Extended Screens

Display a shortcut 
menu by right-clicking 
an Extended Screen

Clicking a screen 
selector activates its 
Extended Screen

Click the Layout button to display the 
Layout menu, described in “Creating 
and using layouts” on page 70

Launch a program by dragging it to an 
Extended Screen from a Quick Launch 
button, the Programs panel, or the Explorer

Choose Update Screens 
from the Task menu to 
refresh the Extended 
Screens

You can have up 
to nine Extended 
Screens

A minimized program is 
shown with a minimized icon

Each running program is 
shown as a miniwindow

Move a program by dragging it 
within its Extended Screen, or 
to another Extended Screen
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Extended Screen
preferences

Use the Customize dialog box to specify your preferences for the 
Extended Screens. Display the Customize dialog box as described in 
“Dashboard preferences” on page 38.

The Customize dialog box for Extended Screens has three pages: 
Screens, Hotkeys, and Sticky Apps.

Screens page
You can choose the number of Extended Screens to be displayed, 
select a background for your screens, and choose whether to display 
the screens in a compact format. Depending on the size of the window 
and your monitor’s resolution, you can display up to nine Extended 
Screens.

What the Extended
Screen shows...

...What you see on the screen
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If you have more than three Extended Screens and then change to a 
smaller number, any programs on the deleted screens are moved onto 
the remaining screens.

To maximize your space for Extended Screens
Include the information for the Resources panel or Clock/Calendar 
panel in the title bar, and hide that panel. To change the title bar, use 
Dashboard preferences as described in “Dashboard preferences” on 
page 38.

 Specifies how to display 
the Extended Screens. 
With three screens, the 
compact display looks 
like this:

Choose the background for the Extended Screens:
- One of the backgrounds supplied with Dashboard.
- The current Windows wallpaper.
- Any .BMP bitmap file. Type the path into the text box, 

or use the Browse button.

Specify the number of screens.Click the tab for 
the Screens page.

Select Extended
Screens to specify

its preferences.

With compact display, you also see 
these buttons you can click to tile 
vertically, tile horizontally, or 
cascade all open windows. 
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Hotkeys page
By assigning hotkeys to your Extended Screens, you can switch 
between Extended Screens without displaying the Dashboard.

Sticky Apps page
When you’re working with Extended Screens, you’ll want some 
programs to be assigned to a single screen. But you might want others—
such as Sidekick or your e-mail program—accessible from every 
Extended Screen. You do this by designating these applications as sticky 
apps.

Type a key combination directly into 
the text box. Here, Ctrl, Alt, and 3 
were all pressed at the same time.
See “Defining hotkeys” on page 40.

Click the tab for 
the Hotkeys page.

Select Extended
Screens to specify

its preferences.



Cruising: The Dashboard panels 69

If you minimize a sticky app, its icon is visible in each Extended 
Screen.

Switching between
Extended Screens

To switch between Extended Screens
Do one of the following:

◆ Click a screen selector. Dashboard remains on top.

◆ Double-click an Extended Screen. If you double-click the screen 
background, Dashboard remains on top. If you double-click a 
program’s miniwindow, the program comes to the top.

◆ Press a hotkey (see “Hotkeys page” on page 68). The program 
comes to the top, if a program is open in that screen.

Extended Screens
are fully

interactive

The Extended Screens are completely interactive with the full-screen 
views. If you move or resize a program window on the full screen, the 
miniwindow also moves and resizes. If you bring one program on top 
of another, the miniwindows on the Extended Screens reflect the 
change.

It also works the other way. If you move miniwindows on the 
Extended Screens, the programs they represent move on the full 
screen.

Lists the currently 
designated sticky 
apps

Adds a sticky app 
from a list of currently 
running programs

Removes the 
selected program 
from the list of sticky 
apps

Click the tab for the 
Sticky Apps page

Select Extended
Screens to specify

its preferences
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In fact, you can move a program miniwindow from one Extended 
Screen to another just by dragging it there.

Creating and
using layouts

A layout is an arrangement of open programs in the Extended 
Screens. You might find, for example, that different arrangements are 
best suited to different tasks, as in the illustration below.

You can create and save layouts for each of your projects or tasks. 
When you start working on a project, load its layout. The programs 
you need automatically open into the designated Extended Screens.

The Layout menu contains the commands to save, load, and manage 
layouts.

NOTE   If you resize the Dashboard window, the screen selectors may 
disappear. If this happens, you can double-click the screens themselves to 
switch back and forth, or define Extended Screen hotkeys.

Two possible layouts

Load a layout by 
choosing it from this 
list of saved layouts

Save the current 
arrangement of 
Extended Screens 
as a new layout

Change a 
previously 
saved layout
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Creating a layout
To create a layout
1 Arrange the programs on the Extended Screens the way you want 

them to appear when the layout opens.

2 Choose Save Layout from the Layout menu.

3 Enter a name for the layout.

Loading a layout on startup
You can designate a layout as a startup layout, which is loaded when 
Dashboard is first opened.

To designate a layout as a startup layout
Check Load Layout On Startup as shown in the preceding section, 
“Creating a layout.”

Although you can create more than one startup layout, you’ll 
probably find that one is enough.

To disable the automatic loading of a startup layout
Hold down the Shift key while Dashboard starts up.

Layouts and the Windows StartUp group
Layouts are one way to load programs automatically; the Windows 
StartUp group is another. Be sure your Dashboard layouts don’t load 
programs that are already loaded by the StartUp group. For maximum 
flexibility, put Dashboard in your Windows StartUp group, and use 
Dashboard’s layouts to load other applications as needed.

Editing program data in layouts
When you save a layout, Dashboard records information for each 
program in the layout.

Loads the layout
when Dashboard

opens. See the
following section,
“Loading a layout

on startup.”

Removes the selected program from the 
layout.

Type the layout name. You can use any 
name you want; this is not a file name.

Lists all programs that are currently open.

Changes properties of the selected 
program. See “Editing program data in 
layouts” on page 71.
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To change a program’s layout information
1 Choose Save Layout or Manage Layouts from the Layout menu.

2 Click Edit.

3 Make changes as shown in the following figure.

Loading a layout
To load a layout
Click the Layout button and choose a layout.

Keep the following in mind when loading layouts:

◆ If a program is already open when you load a layout that uses the 
same program, but is in a different Extended Screen or location 
within the Extended Screen, the program is not repositioned.

◆ Loading a layout doesn’t unload or close any programs that are 
already open. Thus, if you’ve already opened some programs when 
you load a layout, you’ll get the programs in the layout plus the 
open programs. For that reason, you might want to close some or 

Enter a working directory

Enter the program name

Choose a size for the 
window when the program 
launches

Enter program parameters, 
such as a data file to load

Choose a layout to load
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all programs before loading a layout. You can close all programs 
by choosing Close All Programs from the Task menu.

Managing layouts
Choose Manage Layouts from the Layout menu to rename a layout, 
remove an application from a layout, or delete a layout. You can also 
designate a startup layout and edit programs in a layout.

Layouts and configurations
Layouts are different from configurations:

◆ A layout is the arrangement of program windows in the Extended 
Screens.

◆ A configuration is the arrangement of panels (such as the Quick 
Launch panel, Extended Screens, and Printers panel) on the 
Dashboard. Configurations are discussed in “Configuring panels” 
on page 33.

Layouts and configurations are sometimes related. For example, a 
layout that uses five Extended Screens requires a configuration with 

CAUTION   The Delete Layout button deletes the entire layout. Don’t 
confuse it with the Delete button, which removes a program from the layout.

TIP

If you create a complex layout 
that requires a special 
configuration, save the 
configuration as a separate file. 
When you want to work with the 
layout, first open the 
configuration, and then open the 
layout.

Lists programs in the
selected layout

Deletes the selected 
layout

Renames the selected layout

Removes the selected program 
from the selected layout

Lets you change the properties 
of the selected program

Lists available layouts

Lets you select an icon for the layout
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five screens. (If the current configuration has only three screens, 
Dashboard “doubles up” the programs from the extra screens to fit 
into three.)

Games panel After you’ve put Dashboard to work for you, you can use it to help 
you unwind. Use the Games panel to try your luck at poker or a slot 
machine. Or, challenge your mind by solving the slide puzzle.

The Games panel.

Display a shortcut 
menu by right-clicking 
the Games panel.

To see how you’ve been 
playing, double-click the 
Games panel. The Games 
Graph appears, charting 
your progress.

Slide Puzzle

Poker

Slots

Click a piece to slide it to 
the adjacent open slot

Click to deal or draw
Click to adjust

your bet

Click to spin

Click a card to keep 
the card in your hand
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Games panel
preferences

Use the Customize dialog box to specify your preferences for the 
Games panel. Display the Customize dialog box as described in 
“Dashboard preferences” on page 38.

You can choose which game to play and adjust your wager in poker 
and slots. The slide puzzle is a fixed wager depending on which 
puzzle you choose to solve.

Dashboard Run Dashboard Run takes the place of both a DOS prompt and the Run 
command on the Windows Start menu. You can enter DOS 
commands—copy files, view directories, and manage programs—
right from Dashboard.

Choose which game 
to play.

Change the level of 
difficulty for the slide 
puzzle. When you 
select a puzzle, the 
pieces are 
scrambled.

Select Games
to specify its
preferences.
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To launch a program using Dashboard Run
Do any of the following:

◆ Type commands in the Command Line box. You can change 
directories as needed. When you’re in the right directory, you can 
type the program’s file name and press Enter.

◆ Type commands at the prompt in the results window. When you’re 
in the right directory, you can double-click the program’s file name 
in the listing.

◆ When the results window is active (you type into the window, 
rather than into the Command Line box) press Shift+F8 to highlight 
the bottom file name showing in a DIR listing. Use the arrow keys 
to move up or down the listing. Press Enter when you’ve selected 
the desired program.

Enter the command line for
a Windows program, or
enter a DOS command.

Launch Dashboard Run by choosing 
Dashboard Run from the Task menu 
or by clicking the Run button...

...The Dashboard Run 
dialog box appears.

Your command and its
results appear in the

results window. You can
also type commands at the

DOS prompt in this
window.

Finds the program’s location 
and file name.

Click here to pick a command 
from a list of commands you 
have previously run.

Runs the command shown in 
the Command Line box.

Double-click a program to run it

Check this box if you want
the program minimized

when it opens.



Cruising: The Dashboard panels 77

Programs panel The Programs panel displays each of you program groups as a tab. 
Launching a program is as simple as clicking once on its group, and 
clicking the program name. 

If you were running an earlier version of Windows, the Programs 
panel helps your transition to Windows 95. Dashboard’s Programs 
panel provides all the functionality of the Windows 3.1 program 
groups, and more. 

The initial group of Programs tabs consists of programs from your 
Windows 95 Programs menu, including all folders it contains.

Display a shortcut menu 
by right-clicking the 
Programs panel

Snap the Programs panel on or off by 
clicking the Programs panel button or by 
choosing Snap Off from the shortcut menu

Display a shortcut 
menu by right-clicking 
the Programs panel

The Programs panel
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Programs panel
preferences

Use the Customize dialog box to specify your preferences for the 
Programs panel. Display the Customize dialog box as described in 
“Dashboard preferences” on page 38.

The Customize dialog box for the Programs panel has two pages: 
Program Groups and Options.

Launch a program by
choosing the program name

from the menu.
Click the program name, or

select it using the arrow keys
and then press Enter.

Open a program group by double-clicking its tab 
or choosing the group name from the menu.

Click a program group to display a 
menu of items in that group.
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Program Groups page
You can add, delete, reorder, or hide groups, or change a group’s color 
keys.

Hides the selected group 
from the Programs panel.

Changes the selected 
group’s name, file name, 
or color key. See 
“Changing a group’s 
name, file name, or color 
key” on page 83.

Creates a new 
program group.

Deletes the selected 
group.

Opens the selected 
group’s program window.

Select
Programs to

specify
preferences for

the Programs
panel.

To change the order of the program groups, 
drag a group to a new position in the list.

Click the tab for the 
Program Groups page.
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Options page
You can change the appearance of the tabs on the Programs panel and 
sort program groups.

Managing your
program groups

Dashboard program groups organize your programs in tabs. Here are 
some of the things you can do with program groups:

◆ Display program groups as a row of tabs in the Programs panel.

◆ Create groups within a group.

◆ Change a group’s description or file name.

◆ Change the order in which program groups appear in the menu by 
sorting them or dragging the group name to the position you want.

◆ Add a program to a group by dragging the program’s icon from the 
Quick Launch panel to the group window. Or—in the opposite 
direction—instantly create a Quick Launch button by dragging a 
program icon from a group to the Quick Launch panel.

The following sections describe how to add a group, delete a group, 
create a group within a group, add an item to a group, move or copy 
programs between groups, modify a group, and refresh group 
information.

Updates Dashboard with changes you 
have made in the Program Manager. 
See “Refreshing group information” on 
page 84.

Sorts the groups 
alphabetically or by 
color.

Displays the Programs 
panel buttons with two 
lines of text.

Displays colored 
corners on the 
Programs panel tabs.

Select Programs
to specify

preferences for
the Programs

panel.

Click the tab for the 
Options page.
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Adding a group
You can create a new program group right from Dashboard. The new 
group is automatically reflected in the Program Menu.

To create a program group
1 Right-click the Programs panel and choose Customize, or click the 

Customize button and select Programs panel as the item to 
customize. (See “Programs panel preferences” on page 78.)

2 Click New and enter the following information for the group:

Deleting a group
To delete a program group
1 Right-click the Programs panel and choose Customize, or click the 

Customize button and select Programs as the item to customize. 
(See “Programs panel preferences” on page 78.)

2 Select the group to delete.

3 Click Delete.

Dashboard asks you for confirmation, then deletes the group.

Adding an item to a group
You can add a program to a group if the group is open.

To add a program to a program group
1 Open a group by double-clicking its tab in the Programs panel. Or 

click the group tab, and then click the group name at the top of the 
list.

2 Choose New from the File menu, and choose Shortcut.

Enter the group name that will appear on 
the group’s tab in the Programs panel.

Enter a file name for the group. This is the 
.GRP file that keeps track of the group.
If you don’t specify a file name, Dashboard 
assigns a name.

Click a color. This color 
appears on the group’s tab 
in the Programs panel.
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3 Enter the program’s command line, or click Browse and find the 
program you want. Complete the steps for creating a shortcut. The 
new program item’s icon appears in the group window.

You can also add a new item by dragging it from the Explorer, another 
program window, or the Quick Launch panel to the group.

If you are running the Program Manager as your Windows 95 shell, 
the new program item is automatically reflected in the Program 
Manager.

Creating a group within a group
You can reduce the number of items on the Programs panel or 
consolidate your program groups by creating groups within groups. A 
group within another group is called a nested group.

To create a nested group
1 Open a group by double-clicking its tab in the Programs panel.

2 Choose New from the File menu, and choose Folder.

3 Enter the group name you want. The new group’s icon appears in 
the group window.

To open the new group
Double-click its icon. You can then add programs—or even other 
groups—to this nested group.

A nested group appears as an item in the menu for the group that 
contains it. A downward-facing arrow in the menu indicates the 
nested group, and an upward-facing arrow indicates the “parent” 
group.

These nested program groups will function even if you are running 
Program Manager as your Windows 95 shell. However, if you remove 

...to display the menu 
for the nested group

Click the group name...

Click the upward arrow to 
display the “parent” group



Cruising: The Dashboard panels 83

Dashboard from your hard drive, you will receive an error message if 
you try to open a nested group, since Program Manager alone doesn’t 
support nested groups.

Moving or copying programs between groups
To move a program from one group to another
1 Open both program windows.

2 Drag the program icon from one window to the other.

To copy a program from one group to another
1 Open both program windows.

2 Hold down the Ctrl key while dragging the icon from one window 
to the other.

Changing a group’s name, file name, or color key
You can change a program group’s description, file name, or color 
key. If you are running the Program Manager as your Windows 95 
shell, the change is automatically reflected in the Program Manager.

Color keys are the colored corners on the Programs panel tabs.

To change a program group
1 Right-click the Programs panel and choose Customize, or click the 

Customize button and select Programs panel as the item to 
customize. (See “Programs panel preferences” on page 78.)

2 Select the group to change.

Color keys



84 Chapter 4

3 Click Modify and enter the following information for the group:

Refreshing group information
If you make changes in Windows 95 that do not appear in your 
Dashboard program groups, you can refresh the program group 
information by doing one of the following:

◆ Click Reread Groups From System in the Options page of the 
Customize dialog box. (See the figure on page 80.)

◆ Choose Reread Groups from the Programs panel’s shortcut menu.

◆ Exit Dashboard and restart it.

Taskbar The Dashboard Taskbar provides some features not available with the 
Windows 95 taskbar. 

◆ In addition to being able to dock the taskbar at any side of the 
screen, the Dashboard Taskbar can “float” anywhere within the 
window you choose to place it. 

◆ You can right-click an icon in the Dashboard Taskbar and choose 
Task Info to see information about that application.

◆ You can have labeled or unlabeled icons on the Dashboard 
Taskbar.

The Taskbar displays all running programs as buttons. Clicking a 
program’s button switches to that program. The Taskbar can attach to 

To rename program group, 
enter the name here

To change the file name 
associated with this 
group, enter the full path

To change the color of the corner 
tab for this group’s Programs panel 
button, click a color
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the Dashboard, float as a snapped off palette, or dock to the left, right, 
top, or bottom of your screen.

Taskbar
preferences

Use the Customize dialog box to specify your preferences for the 
Taskbar. Display the Customize dialog box as described in 
“Dashboard preferences” on page 38.

The Customize dialog box for the Taskbar has two pages: Taskbar and 
Settings.

Snap the Taskbar on or off by clicking the 
Taskbar button or by choosing Snap Off 
from the shortcut menu

Display a shortcut 
menu by right-clicking 
the Taskbar

Display a shortcut 
menu by right-clicking 
the Taskbar

The 
Taskbar

This Taskbar is docked at
the bottom of the screen
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Taskbar page
You can specify the position of the Taskbar or dock it to the edge of 
your screen.

Settings page
You can specify the button style and whether to show icons.

Select
Taskbar to
specify its

preferences.

Click the tab for the 
Taskbar page.

Click to make the 
Taskbar a floating 
palette.

Click to attach the 
Taskbar to the top, 
bottom, left, or right 
side of the screen.

Click to make the 
Taskbar disappear 
when you don’t need 
it. It reappears when 
you move the mouse 
to the edge of the 
screen.Click to keep the Taskbar in 

front of all other windows, even 
if another window is active.

Click the tab for the 
Settings page.

When Labeled is 
checked, the 
program names 
appear along with 
their icons.

Click to hide the 
icons of programs 
that are minimized. 
They are still 
available in the 
Taskbar. This option 
applies only if you 
are running a 
Windows shell such 
as Program 
ManagerCheck to show an icon for 

each program in the Taskbar, 
along with its description.

Select
Taskbar to
specify its

preferences.
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Symbols
? icon 17

A
accessing applications 51, 68–69
activating shortcut menus 11
adding items to groups 81–82, 83
adding panels 42
adding program groups 79, 81
adding users ii
Alarm Settings dialog box 60
alarms

Clock/Calendar 59–61
assigning sounds 61
setting preferences 59

Clock/Calendar panel 57
assigning sounds 60
specifying messages 60

low memory resources 53, 54
turning off 59

Alarms command 59
Alarms page (Customize) 59
analog clocks 58
App Organizer 6, 44

running 47
Appearance page (Customize) 40
Application Task Information 

dialog box 33
applications 6

accessing 51, 68–69
launching 29–32, 49

setting alarms 60
setting preferences 46
shortcuts 30

minimized 31, 32, 33, 76
multiple 31, 32–33, 50
removing from layouts 73
returning information on 55
switching 33, 68, 69
viewing 33, 84

Applications page 
(Customize) 46

Applications Running option 55
Arrange Icons button 33
arranging windows 3
associating files with groups 84
associating files with Quick 

Launch buttons 49
automatically opening 

applications 49

B
backgrounds (Extended 

Screens) 67
bar gauge (resources) 53, 54
book icons 19
Browse button 32
bulletin boards 4
button bars See snap-on panels
buttons

See also specific button
described 11
help with 17–18

C
Calendar page (Customize) 58
calendar See Clock/Calendar 

panel
Cascade button 33
cascading windows 3
changing

layouts 70, 71, 72
program fonts 40
system dates and time 57, 58

choosing backgrounds 67
Clock page (Customize) 58
Clock/Calendar panel 56–61

adding alarms 57, 59–61
changing calendar dates 57
modifying system dates and 

time 57, 58
overview 14
setting preferences 57–59

color options 41

calendar 58
program groups 79, 80, 81, 83

Command Line box 76
communication programs 58
compatiblity with Windows 3.1 6
configuration files 35–36

opening 36
configuration settings 34–36

See also preferences
saving 34, 35, 36

contacting Starfish 4
Contents page (Help) 18–19
controls See buttons; menus; 

panels
copying program groups 83
copying Quick Launch buttons 48
CPU meter 52
creating program groups 79, 81
customer assistance 4
Customize button 34
Customize command 34, 38
Customize dialog box 34, 38

discarding changes 36
saving settings 36

customizing Dashboard 24–29, 
38–43

See also preferences

D
Dashboard

adding additional users ii
customizing 24–29, 38–43
installing 4, 5, 6–7

over previous versions 6
new features 3
overview 9–17
repositioning 28–29
resizing 27
running 5, 40
upgrading ii

Dashboard option 26
Dashboard page (Customize) 39
Dashboard Run 40, 75–76
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launching programs32, 76
overview 15

dates See Clock/Calendar panel
default printer, setting62, 63
defining hotkeys40
Delete button73
Delete Layout button73
deleting See removing
Desktop group6, 44

updating47
dialog boxes, help with18
digital clocks58
directories, working46
Disable ToolTips command21
disabling

alarms59, 61
calendar58
clock 58
startup layouts71

disk space, returning55
Display button (Help)21
displaying

calendar58
clock 58
current applications33, 84
Help topics19–21
icons in panels39
installed printers63
shortcut menus11
ToolTips 21

Documents group6, 44
updating47

DOS commands, entering76
DOS environment variables56
drag and drop23–24
Drive Usage option55
Drive Watch 52, 55
drivers

mouse5
sound7

Drives page (Customize)54

E
editing layouts72
Email/Internet group44
enabling ToolTips42
entering DOS commands76
Environment Variables option56
Explorer, accessing50

Extended Screens panel65–74
accessing applications68–69
arranging icons33
changing fonts40
choosing backgrounds67
displaying icons39
launching programs30, 65
layouts 70–74

creating71
deleting 73
loading 72

on startup71
saving 70, 71

maximizing space67
moving programs65, 69–70
overview 14–15
setting preferences66–69

F
fax machines61, 64
files

associating with groups84
configuration35–36
loading 49

Find, accessing50
Find button (Help)20
Find tab (Help)20
Flyover help See ToolTips
fonts 40
freeing memory26
fuel gauge (resources)53, 54
full-text searches (Help)20–21

G
Games Graph74
Games panel74–75

overview 15
groups (program)7, 77

See also Programs panel
groups (Quick Launch panel)46

creating6, 48
sorting 47

Groups page (Customize)46, 48

H
hard disk space55
hardware requirements5
help 4, 17–21

on tools 21
Help buttons17, 18
Help system18–21

full-text searches20–21
indexes19

Hide command26
Hide Item button26
hiding panels25–26, 42
hiding program groups79
horizontal views27
hotkeys30

defining 40
Extended Screens panel68
Quick Launch panel50

Hotkeys page (Customize)40, 68

I
icons 39

arranging33
Index button (Help)19
Index tab (Help)19
INSTALL.EXE 6
installation 4, 5, 6–7

output devices63
over previous versions6
sound drivers7

Internet access44

K
keeping appointments59
keys, reassigning40

See also hotkeys

L
labeling Quick Launch buttons47
landscape mode64
launching applications29–32, 49

multiple 31, 50
setting alarms60
setting preferences46
shortcuts30

Layout button31, 65, 72
Layout menu31, 70
layouts (Dashboard)31
layouts (Extended Screens)70–74

creating71
deleting 73
loading 72
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on startup71
saving 70, 71

Layouts group6, 44
updating47

Load command36
Load Configuration File dialog 

box 36
Load Layout On Startup 

option 71
loading files49

See also opening

M
Manage Layouts command72, 73
managing projects70
memory 5

freeing 26
tracking 52, 54

specific applications55
Memory and Resources option54
memory odometer53, 54
Memory page (Customize)53
menus11, 78

See also shortcut menus
minimized applications31, 32, 

33, 76
miniwindows 15, 69
mouse5

shortcuts, defining40
terms, defined5

mouse pointer24
moving panels24, 24–25
moving program groups83
multiple applications32–33

See also Extended Screens 
panel

launching31, 50

N
nesting program groups82–83
network drives55
new features3

O
office software packages44
online help4, 17–21

tools 21
online information services4

opening
applications29, 76

automatically49
configuration files36
program groups78, 82
shortcut menus11
Task Manager33

Options page (Customize)47, 64, 
80

orientation (print)64
output devices54, 61

installing 63

P
panels10, 38

See also specific panel
configuring 33–36
help with 17–18
hiding 25–26, 42
missing portions29
overview 12–17
rearranging24–25
resizing 27, 45
setting preferences42
snap-on/off27, 42

Panels page (Customize)43
Panels tab26
paper orientation64
plotters 61
poker 74
portrait mode64
preferences38–43

Clock/Calendar panel57–59
Extended Screens panel66–68
Games panel75
Printers panel62–64
Programs panel78–80
Quick Launch panel45–47
Resources panel53–56
saving settings36
Taskbar85–86
Win Tools panel51

previous versions, installing 
over 6

Print Manager See Printers panel
printer buttons63, 64
printers 61

reassigning default62, 63
removing 63

viewing installed63
Printers page (Customize)63
Printers panel61–64

changing default printer62, 63
hiding 42
overview 14
removing printers63
resizing 27
setting preferences62–64
specifying paper 

orientation64
printing 24, 64
program fonts40
program groups7, 77

See also Programs panel
Program Groups page79
Program menu See Programs 

panel
Programs panel77–84

adding items to groups81–82, 
83

changing fonts40
creating groups79, 81
displaying icons39
hiding 42
launching programs30–31
nesting groups82–83
opening program groups78, 

82
overview 16
refreshing group 

information 84
removing groups79, 81
renaming groups79, 83–84
setting preferences78–80

programs See applications
projects, managing70

Q
question mark icon17
Quick Launch buttons30

associating files with49
creating6, 48–49
labeling 47

Quick Launch panel44–50
adding programs45, 46, 48
deleting programs46
groups46

creating6, 48
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sorting 47
hiding 42
overview 12
resizing 27
setting preferences45–47
specifying hotkeys50

R
rearranging panels24–25
reassigning keys40
recurring alarms60
refreshing group information84
registration6
reminders See alarms
removing

applications from layouts73
panels25–26, 42, 43
program groups79, 81
programs from layouts71
Quick Launch programs46
ToolTips 21

renaming layouts73
renaming program groups79, 83–

84
reordering program groups79
repositioning Dashboard28–29
Reread Groups button84
resizing

Dashboard27, 29, 70
panels27, 45

Resource Gauge52
Resources dialog box53, 54–56
Resources panel51–56

overview 13
returning disk space55
setting preferences53–56
tracking memory52, 54

specific applications55
viewing environment 

variables56
Re-Synchronize button47
Run button32
Run command32
Run dialog box See Dashboard 

Run
running App Organizer47
running applications See 

launching applications
running Dashboard5, 40

S
Save Layout command71, 72
saving

configuration settings34, 35, 
36

layouts 70, 71
preferences36

Screens page (Customize)66
searching online help19, 20–21
selecting backgrounds67
sending faxes64
setting preferences38–43

Clock/Calendar panel57–59
Extended Screens panel66–68
Games panel75
Printers panel62–64
Programs panel78–80
Quick Launch panel45–47
Resources panel53–56
Taskbar85–86
Win Tools panel51

Settings page (Customize)86
shortcut menus11–12

Clock/Calendar panel56
Extended Screens panel65
Games panel74
Printers panel61
Programs panel77
Quick Launch panel44
Resources panel52
Win Tools panel50

shortcuts
See also hotkeys
launching applications30
mouse, defining40

slide puzzle74
slot machine74
Snap Off command28
Snap Off page (Customize)42
Snap On command28
snap-off panels27, 42
snap-on panels27, 42
Snooze button61
snooze intervals59
software requirements5
sorting program groups80
sorting Quick Launch groups47
sound drivers7

sound files7
sounds, assigning to alarms60, 61
Starfish, contacting4
startup layouts71

disabling 71
sticky apps68–69
Sticky Apps page (Customize)68
support hotline4
switching applications33, 68, 69
system dates and time56

changing57, 58
System Environment option54
system resources See Resources 

panel

T
tabs (Programs panel)77, 80
Task Manager33
Task Manager button33
Taskbar84–86

hiding 42
overview 16–17
setting preferences85–86

Taskbar page (Customize)86
technical support4
Tile button 33
tiling windows 3
time See Clock/Calendar panel
tips See ToolTips
title bar 39

changing fonts40
Toolbars See snap-on panels
ToolTips 21

enabling42
tracking memory52, 54

specific applications55
turning off alarms59, 61

U
unlabeling Quick Launch 

buttons47
upgradingii, 6
users, addingii
Utilities group 44

V
Vertical command28
vertical views27, 28
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viewing
calendar58
clock 58
current applications33, 84
Help topics19–21
icons in panels39
installed printers63
shortcut menus11
ToolTips 21

W
wallpaper (Extended Screens)67
Web browser44
Web site4
Win Tools panel50–51

overview 13
setting preferences51

Windows 3.1 compatibility6
Windows applications See 

applications
windows, arranging3, 33
working directories46
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pages viewed.

Sets the page view to 100%.

Displays the entire page within 
the window.

Displays the full width of the 
page within the window.

Searches for a word or 
partial word.

Prints a page or multiple pages 
from the online manual. Specify 
the page range in the dialog box 
that appears. The default, All, 
prints the entire manual.
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